
 
 

Руководство пользователя и 

технические характеристики NI 

5731/5732/5733/5734R 
NI 5731/5732/5733/5734 - семейство адаптеров модулей высокоскоростных 

дигитайзеров, созданных для совместной работы с модулем NI FlexRIO 

FPGA. В данном документе содержатся информация о сигналах и технические 

характеристики модуля NI 5731/5732/5733/5734R, состоящего из модуля NI 

FlexRIO FPGA и NI 5731/5732/5733/5734. В этом документе содержатся также 

разделы руководств, демонстрирующих сбор данных при помощи примера VI 

LabVIEW FPGA, а также создание и запуск собственного проекта LabVIEW c 

NI 5731/5732/5733/5734R. 

Примечание Обозначение NI 5731/5732/5733/5734R относится к комплеку из вашего 

адаптера модуля NI 5731/5732/5733/5734 и модуля NI FlexRIO FPGA. Обозначение  

NI 5731/5732/5733 /5734 относится только к адаптеру модуля NI 5731/5732/5733/5734. 

Описание каждого из устройств NI 5731/5732/5733/5734 приведено ниже: 

 NI 5731 — дигитайзер с 2 каналами аналогового ввода, 12-разрядный, 40 

МОтсчетов/с  

 NI 5732 — дигитайзер с 2 каналами аналогового ввода, 14-разрядный, 80 

МОтсчетов/с  

 NI 5733 — дигитайзер с 2 каналами аналогового ввода, 16-разрядный, 120 

МОтсчетов/с  

 NI 5734 — дигитайзер с 4 каналами аналогового ввода, 16-разрядный, 120 

МОтсчетов/с 
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Примечание Перед конфигурированием NI 5731/5732/5733/5734R необходимо 

установить соответствующее программное и аппаратное обеспечение. Инструкции по 

установке приведенв в документе NIFlexRIO FPGA Module Installation Guide and 

Specifications. На рисунке 1 показан пример правильно подключенного устройства NI 

FlexRIO. 

 
Адаптер модуля  

NI FlexRIO 
+ 

Модуль  
NI Flex RIO FPGA  

= Устройство NI FlexRIO 

Рисунок 1. Устройство NI FlexRIO 

Электромагнитная совместимость 

Данный продукт протестирован и соответствует требованиям и ограничениям 

нормативных документов по электромагнитной совместимости (EMC), 

приведенным в технических характеристиках продукта. Эти требования и 

ограничения предоставляют достаточную защиту от вредных помех при 

эксплуатации продукта в надлежащей электромагнитной среде. 

Продукт предназначен для использования в промышленных условиях. Не 

гарантируется отсутствие вредных помех в случае, если продукт подключен к 

тестируемому объекту, или если продукт используется в жилых помещениях. 

Для минимизации потенциальных помех приему теле- и радиосигналам и 

предотвращения неприемлемого ухудшения характеристик, устанавливайте и 



 

© National Instruments Corporation 3  Руководство и характеристики NI 5731/5732/5733/5734R 

используйте данный продукт в строгом соответствии с инструкциями, 

приведенными в настоящем документе. 

Кроме того, любые внесенные в продукт изменения или модификации, не 

одобренные в явном виде National Instruments, могут лишить вас права 

эксплуатировать продукт согласно местным нормативным правилам. 

Внимание Для обеспечения соответствия указанной электромагнитной совместимости 

вы должны установить панели заглушки PXI EMC Filler Panels (шифр изделия National 

Instruments 778700-01) в соседние слоты шасси. Для получения дополнительной 

информации об установке панелей-заглушек обратитесь к разделу Приложение: 

Установка элементов для уменьшения уровня электромагнитных помех данного 

документа. 
 

Внимание Для обеспечения соответствия указанной электромагнитной совместимости 

используйте данный продукт только с экранированными кабелями и аксессуарами. 
 

Внимание Для обеспечения соответствия указанной электромагнитной совместимости 

установите включенные в поставку ферритовые кольца (шифр изделия National 

Instruments 711856-01) на любой кабель, подключенный к разъему AUX I/O, в 

соответствии с инструкциями, приведенными в разделе  Приложение: Установка 

элементов для уменьшения уровня электромагнитных помех. 
 

Внимание Данный продукт чувствителен к электростатическим разрядам (ESD). Для 

обеспечения соответствия указанной электромагнитной совместимости следуйте 

инструкциям по программированию, перечисленным в конце разделов Использование 

вашего устройства с LabVIEW FPGA Example VI и Создание проекта LabVIEW и 

запуск VI на целевом устройстве FPGA этого документа. 
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Как использовать ваш комплект документации NI 

FlexRIO 

Обратитесь к рисунку 2 и таблице 1, чтобы узнать, как использовать ваш комплект 

документации FlexRIO. 

 

Рисунок 2. Как использовать ваш комплект документации NI FlexRIO 
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Таблица 1. Местоположение и описание документации NI FlexRIO 

Документ Местоположение Описание 

Руководство по установке 

и технические 

характеристики модуля 

NI FlexRIO FPGA* 

Доступно в 

комплекте поставки 

модуля FPGA и из 

меню Пуск. 

Содержит инструкции по установке 

вашей системы NI FlexRIO и технические 

характеристики вашего модуля FPGA. 

Руководство пользователя 

и технические 

характеристики адаптера 

модуля NI FlexRIO 

Доступно из меню 

Пуск. 

Содержит информацию о сигналах, 

примеры и технические характеристики 

вашего адаптера модуля. 

Справка LabVIEW FPGA 

Help* 

Встроена в справку 

LabVIEW Help. 

Содержит информацию о базовой 

функциональности модуля LabVIEW 

FPGA. 

Справка NI FlexRIO* Доступна из меню 

Пуск. 

Содержит информацию по настройке 

модуля FPGA, адаптера модуля и CLIP. 

Примеры LabVIEW Доступны в 

поисковике 

примеров NI 

Example Finder. 

Содержат примеры FPGA VI и хост-VI на 

вашем устройстве. 

Другая полезная информация на сайте ni.com 

ni.com/ipnet Содержит функции LabVIEW FPGA и IP-ядра совместного 

пользования. 

ni.com/flexrio Содержит информацию о продуктах и технические 

характеристики устройств NI FlexRIO. 

* эти документы доступны также на сайте ni.com/manuals. 
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Лицевая панель и схема расположения контактов на 

разъеме 

Лицевая панель 

В таблице 2 показаны разъем лицевой панели и приведено описание сигналов 

для NI 5731/5732/5733/5734. Обратитесь к разделу Технические 

характеристики этого документа для получения дополнительной информации 

о сигналах.  

Таблица 2. Разъемы лицевой панели NI 5731/5732/5733/5734  

 

Разъем Описание сигнала 

AI 0 Вход канала 0 аналоговый несимметричный, 50 Ом. 

AI 1 Вход канала 1 аналоговый несимметричный, 50 Ом. 

AI 2 Вход канала 2 аналоговый несимметричный, 50 Ом (только для NI 5734). 

AI 3 Вход канала 3 аналоговый несимметричный, 50 Ом (только для NI 5734). 

CLK IN Вход опорного или внешнего тактового сигнала, 50 Ом, несимметричный. 

AUX I/O Обратитесь к таблице 3 за списком и описанием сигналов. 

 

 

Внимание Подключения сигналов, которые превышают любое из максимальных 

значений на любом из разъемов NI 5731/5732/5733/5734, могут повредить устройство и 

шасси. NI не несет ответственность за повреждения, вызванные подключениями 

таких сигналов. За максимальными значения входных и выходных сигналов обратитесь 

к разделу Технические характеристики этого документа. 
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Разъем AUX I/O 

В таблице 3 приведены назначения контактов разъема AUX I/O на NI 

5731/5732/5733/5734. 

Таблица 3. Назначения контактов разъема AUX I/ONI 5731/5732/5733/5734 

 

Разъем  
AUX I/O 

Контакт Сигнал Описание сигнала 

 

1 Порт  

DIO 0 (0) 

Двунаправленный несимметричный канал 

цифрового ввода-вывода. 

2 GND Опорный уровень для сигналов. 

3 Порт  

DIO 0 (1) 

Двунаправленный несимметричный канал 

цифрового ввода-вывода. 

4 Порт  

DIO 0 (2) 

Двунаправленный несимметричный канал 

цифрового ввода-вывода. 

5 GND Опорный уровень для сигналов. 

6 Порт  

DIO 0 (3) 

Двунаправленный несимметричный канал 

цифрового ввода-вывода. 

7 Порт  

DIO 1 (0) 

Двунаправленный несимметричный канал 

цифрового ввода-вывода. 

8 GND Опорный уровень для сигналов. 

9 Порт  

DIO 1 (1) 

Двунаправленный несимметричный канал 

цифрового ввода-вывода. 

10 Порт  

DIO 1 (2) 

Двунаправленный несимметричный канал 

цифрового ввода-вывода. 

11 GND Опорный уровень для сигналов. 

12 Порт  

DIO 1 (3) 

Двунаправленный несимметричный канал 

цифрового ввода-вывода. 

13 PFI 0 Двунаправленный несимметричный канал 

цифрового ввода-вывода. 

14 NC Не подключен 

15 PFI 1 Двунаправленный несимметричный канал 

цифрового ввода-вывода. 

16 PFI 2 Двунаправленный несимметричный канал 

цифрового ввода-вывода. 

17 GND Опорный уровень для сигналов. 

18 +5V Питание +5 В (максимум 10 мА) 

19 PFI 3 Двунаправленный несимметричный канал 

цифрового ввода-вывода. 
 

Внимание Разъем AUX I/O совместим со стандартным кабелем HDMI сторонних 

производителей, но порт AUX I/O не является интерфейсом HDMI. Не подключайте 

порт AUX I/O NI 5731/5732/5733/5734 к порту HDMI другого устройства. NI не несет 

ответственность за повреждения, вызванные подобным подключением сигналов. 
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Блок-схема 

На рисунке 3 показана блок-схема NI 5731/5732/5733/5734 и поток сигналов 

в/из IP компонентного уровня (CLIP) NI 5731/5732/5733/5734 между адаптером 

модуля и соответствующий CLIP в LabVIEW FPGA. 

 

Рисунок 3. Блок-схема. Сигналы разъема NI 5731/5732/5733/5734 и сигналы CLIP 
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IP компонентного уровня (CLIP)  

NI 5731/5732/5733/5734 

Модуль LabVIEW FPGA предоставляет возможность интеграции HDL IP под 

названием CLIP. Устройства NI FlexRIO поддерживают два типа CLIP: 

определяемый пользователем и подключаемый. 

 Определяемый пользователем CLIP позволяет внедрять HDL IP в целевое 

устройство FPGA, обеспечивая коду VHDL возможность непосредственно 

взаимодействовать с FPGA VI. 

 Подключаемый CLIP предоставляет такую же функциональность 

интеграции с IP, как и определяемый пользователем, но позволяет CLIP 

непосредственно взаимодействовать также и с внешними по отношению к 

FPGA схемами. Подключаемый CLIP адаптера модуля позволяет вашему IP 

непосредственно взаимодействовать и с FPGA VI и с разъемом внешнего 

интерфейса адаптера модуля. 

На рисунке 4 показаны связи между FPGA VI и CLIP. 

 

Рисунок 4. Связи CLIP и FPGA VI 

NI 5731/5732/5733/5734 поставляется с подключаемыми CLIP, которые могут 

использоваться для добавления модуля ввода-вывода в проект LabVIEW. 
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NI 5731/5732/5733/5734 CLIP предоставляют доступ к двум каналам 

аналогового ввода (четырем для NI 5734), восьми двунаправленным каналам 

цифрового ввода-вывода, четырем двунаправленным каналам PFI и селектору 

входного тактового сигнала, который может быть настроен одним из 

следующих способов:  

 Внутренним тактовым сигналом (Internal Sample clock) 

 Внутренним тактовым сигналом, синхронизированным c внешним 

опорным сигналом (Reference clock) с разъема CLK IN 

 Внешним тактовым сигналом (External Sample clock )  

с разъема CLK IN 

 Внутренним тактовым сигналом, синхронизированным c внешним 

опорным сигналом с разъема Sync Clock 

Элементы CLIP содержат также движок для программирования АЦП и 

тактовых сигналов предварительно заданными параметрами для более простой 

настройки прибора, или через адрес интерфейса SPI для более продвинутой 

настройки. В модуле LabVIEW FPGA доступ к данным аналогового ввода 

осуществляется типом данных U16 (с выравниванием влево). Сигналы DIO 

группируются в два порта по четыре сигнала каждый, и доступ к ним 

осуществляется типом данных U8 и булевским сигналом разрешения записи. К 

четырем сигналам PFI доступ осуществляется индивидуально с использованием 

булевского типа данных. 

Обратитесь к справке NI FlexRIO Help для получения дополнительной 

информации об элементах NI FlexRIO CLIP, конфигурировании NI 

5731/5732/5733/5734 с подключаемыми CLIP, и списком доступных сигналов 

подключаемых CLIP. 

Кабели 
 

 Используйте любой 50 экранированный коаксиальный кабель длиной 

менее 3 м с разъемом BNC для подключения к разъемам AI 0, AI 1, AI 2 и 

AI 3 на лицевой панели NI 5731/5732/5733/5734. 

 Используйте любой 50  экранированный коаксиальный кабель длиной 

менее 3 м с разъемом SMB для подключения к разъему CLK IN. 

 Используйте любой кабель HDMI с предоставленным ферритовым кольцом 

для подключения к сигналам цифрового ввода-вывода и сигналам PFI на 

разъеме AUX I/O.  

Внимание Для обеспечения соответствия указанной электромагнитной совместимости 

установите включенные в поставку ферритовые кольца (шифр изделия National 

Instruments 711856-01) на любой кабель, подключенный к разъему AUX I/O, в 

соответствии с инструкциями, приведенными в разделе  Приложение: Установка 

элементов для уменьшения уровня электромагнитных помех. 
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Таймирование 

Тактовые сигналы NI 5731/5732/5733/5734 управляют частотой дискретизации 

и другими функциями таймирования устройства. В таблице 4 приведена 

информация о возможных источниках тактовых сигналов NI 

5731/5732/5733/5734. 

Таблица 4. Источники тактовых сигналов NI 5731/5732/5733/5734 

 

Конфигурация 

тактового 

сигнала 

Поддерживаемые 

частоты, 

МОтсчетов/с 

Тип 

внешнего 

тактового 

сигнала 

Частота внешнего 

тактового сигнала, 

МГц 
Описание 

Встроенный 

тактовый 

генератор 

без ФАПЧ 

NI 5731 = 40 

NI 5732 = 80 

NI 5733 = 120 

NI 5734 = 120 

— — Внутренний кварцевый 

генератор, работающий 

как независимый 

генератор тактовых 

импульсов. 

Встроенный 

тактовый 

генератор 

с ФАПЧ 

(IoModSynClk) 

NI 5731 = 40 

NI 5732 = 80 

NI 5733 = 120 

NI 5734 = 120 

— 10  Внутренний кварцевый 

генератор синхронизи-

руется IoModSyncClk 

(Sync Clock), который 

поступает только через 

объединительную 

панель поддержива-

емых устройств. 

Встроенный 
тактовый 
генератор 
с ФАПЧ 
(CLK IN) 

NI 5731 = 40 

NI 5732 = 80 

NI 5733 = 120 

NI 5734 = 120 

Reference 
clock. 

10  Внутренний кварцевый 
генератор синхронизи-
руется внешним 
сигналом Reference 
clock, который 
поступает через разъем 
лицевой панели CLK 
IN. 

Внешний 

генератор 

(CLK IN) 

Поддерживаемая 

тактовая частота 

равна частоте 

внешнего тактового 

сигнала 

 

Sample 

clock. 

NI 5731 мин. = 3  Внешний тактовый 

сигнал можно 

подключать через 

разъем лицевой панели 

CLK IN. 

NI 5731 макс. = 40  

NI 5732 мин = 20 * 

NI 5732 мин = 10 † 

NI 5732 макс. = 80  

NI 5733 мин = 50  

NI 5733 макс. = 120  

NI 5734 мин = 50  

* со включенным стабилизатором скважности (DCS). По умолчанию стабилизатор скважности 

включен во всех элементах CLIP NI 5731/5732/5733/5734. Вы можете выключить DCS с 

помощью регистра 9 в АЦП. 

† DCS отключен. 
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Примечание Технические характеристики адаптеров модулей NI 5731/5732/5733/5734 

были получены только при максимальной частоте дискретизации.  

 

Примечание Для получения дополнительной информации о настройке тактовых 

сигналов обратитесь к соответствующему разделу справки CLIP для вашего устройства 

в справке NI FlexRIO Help. 

Использование вашего устройства с примером 

LabVIEW FPGA VI 
Примечание Перед запуском этого примера вы должны установить поддержку 

адаптера модуля (NI FlexRIO Adapter Module Support). Подробная информация об 

установке приведена в документе NIFlexRIO FPGA Module Installation Guide and 

Specifications. 

Программное обеспечение NI FlexRIO Adapter Module Support включает примеры проектов, 

которые помогут вам начать создавать приложения LabVIEW FPGA. В данном разделе 

объясняется, как использовать имеющийся пример проекта LabVIEW FPGA для генерации 

и сбора отсчетов с NI NI 5731/5732/5733/5734R. Для этого примера требуется как минимум 

один кабель BNC для подключения сигналов к вашему устройству. 

Примечание Доступные для вашего устройства примеры зависят от версии 

используемых вами программного обеспечения и драйвера. Для получения 

информации о версиях ПО, совместимых с вашим устройством, посетите страницу 

ni.com/info и введите информационный код rdsoftwareversion. 

Каждый пример проекта NI 5731/5732/5733/5734R включает следующие элементы: 

 LabVIEW FPGA VI, который может быть откомпилирован и запущен на встроенном в 

оборудовании FPGA. 

 VI, который выполняется на компьютере с ОС Windows и взаимодействует с LabVIEW 

FPGA VI. 

Примечание В программном обеспечении модуля LabVIEW FPGA, адаптеры модулей 

NI FlexRIO обозначаются как модули ввода-вывода (IO Modules). 

Выполните следующие шаги для запуска примера, который измеряет сигнал на входе AI 0 

NI 5731/5732/5733/5734. 

1. Подключите один конец кабеля BNC к разъему AI0 на лицевой панели  

NI 5731/5732/5733/5734, а второй конец - к вашему тестируемому устройству. 

2. Запустите LabVIEW. 

3. В окне Getting Started щелкните по пункту Find Examples для запуска поисковика 

примеров NI Example Finder. 
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4. В поисковике примеров NI Example Finder выберите Hardware Input and 

Output»FlexRIO»IO Modules»NI 573X»NI 573y (где y означает серийный номер 

вашего устройства). 

5. Выберите NI 573y - Getting Started.lvproj. Дождитесь открытия проекта. 

6. В окне Project Explorer откройте NI 573y - Getting Started (Host).vi в разделе My 

Computer. Откроется хост-VI. Функция Open FPGA VI Reference в этом VI 

использует NI 7952R как целевое устройство FPGA по умолчанию. Если вы 

используете другой модуль NI FlexRIO FPGA, выполните следующие шаги, чтобы 

заменить поддерживаемое FPGA VI целевое устройство. 

a. Выберите в меню Window»Show Block Diagram, чтобы открыть блок-

диаграмму VI. 

b. Щелкните правой кнопкой мыши по функции Open FPGA VI Reference (NI 

PXI-7952R) и выберите Configure Open FPGA VI Reference. 

c. В диалоговом окне Configure Open FPGA VI Reference щелкните по кнопке 

Browse рядом с кнопкой Bitfile. 

d. В диалоговом окне Select Bitfile выберите двоичный файл для вашего 

устройства. Имя двоичного файла компонуется из адаптера модуля, типа 

примера и модуля FPGA. 

e. Щелкните по кнопке Select. 

f. Щелкните по кнопке OK в диалоговом окне Configure Open FPGA VI 

Reference. 

g. Сохраните VI. 

7. На лицевой панели выберите из выпадающего меню RIO Resource ресурс, 

соответствующей выбранному на шаге 6 целевому устройству.  

8. Выберите AI 0 в элементе управления AI Channel  

9. Установите желаемые значения элементов Trigger Level (V) и Record Size . 

10. В элементе управления Trigger Type вы можете выбрать Software Trigger или 

Data Edge. При выборе Software Trigger VI собирает данные при каждом щелчке 

по кнопке Software Trigger на лицевой панели VI. При выборе Data Edge VI 

собирает данные по каждому фронту.  

11. Задайте Sample Rate равной тактовой частоте по умолчанию вашего устройства.  

Примечание Элемент управления Sample Rate не изменяет частоту дискретизации в 

вашем устройстве; он только корректирует отображение времени. 

12. Щелкните по кнопке Run, чтобы запустить VI. 

13. Щелкните по кнопку Software Trigger , если выбрали Software Trigger в элементе 

управления Trigger Type . 

VI собирает данные и отображает полученный сигнал на графике Acquired 

Waveform , показанном на рисунке 5. 

14. Щелкните по кнопке Stop, чтобы остановить VI. Закройте VI. 
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Рисунок 5. Лицевая панель NI 573x - Getting Started (Host) VI 

Примечание (только для NI 5731) Электростатические разряды могут повлиять на 

импульсы дискретизации в NI 5731, что может привести к ошибке -50400 при 

выполнении передачи данных по каналу DMA или к иным ошибкам в характеристиках 

тактового сигнала и выхода по тайм-ауту при сборе данных в NI 5731. Чтобы 

гарантировать, что NI 5731 выполнит самовосстановление после этой ошибки, хост и 

FPGA VI должны быть способны зафиксировать ошибки по тайм-ауту и 

реинициализировать FPGA. Приведенные ниже два шага описывают, как 

реинициализировать NI 5731: 

1. Для получения дополнительной информации о фиксации ошибки посетите Базу 

Знаний на странице ni.com/kb, введите информационный код 3BPD5HRY и 

выберите статью Ignoring a Particular Error in an Error Cluster in LabVIEW. 

2. Для реинициализации FPGA обратитесь к разделу Reset (Invoke Method) справки NI 

FPGA Module Help, доступной в LabVIEW и на странице ni.com/manuals. 

Создание проекта LabVIEW и запуск VI на целевом 

устройстве FPGA 

В этом разделе рассматривается настройка целевого устройства и создание 

FPGA VI и хост-VI для обмена данными. Для получения более подборной 

информации о сборе данных вашим устройством NI 5731/5732/5733/5734, 

обратитесь к конкретным примерам для устройств, доступным в поисковике 

примеров NI Example Finder. 
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Создание проекта 

1. Запустите LabVIEW или, если он уже запущен, выберите меню File»New. 

2. В диалоговом окне New выберите Project»Empty Project и щелкните по 

кнопке OK. Новый проект откроется в окне Project Explorer. 

3. Сохраните проект как 573xSampleAcq.lvproj. 

Создание FPGA VI 

1. В окне Project Explorer щелкните правой кнопкой мыши по My Computer 

и выберите New»Targets and Devices. 

2. В окне Add Targets and Devices on My Computer выберите кнопку 

Existing Target or Device и разверните FPGA Target. Отобразится целевое 

устройство. 

3. Выберите ваше устройство и щелкните по кнопке ОК. Целевое устройство 

и его свойства загрузятся в окно Project Explorer. 

4. В окне Project Explorer раскройте FPGA Target (RIOx, PXI-79xxR). 

5. Щелкните правой кнопкой мыши по FPGA Target (RIOx, PXI-79xxR) и 

выберите New»FPGA Base Clock. 

6. В выпадающем меню Resource выберите IO Module Clock 0. 

7.  Введите тактовую частоту по умолчанию вашего устройства (40, 80, или 

120) в элемент Compile for single frequency и щелкните по кнопке OK. 

8. Щелкните правой кнопкой мыши по IO Module в окне Project Explorer и 

выберите Properties. 

9. Выберите NI 573x из списка IO Module. Доступный CLIP для NI 

5731/5732/5733/5734 отобразится в категории General панели Component 

Level IP. Если эта категория недоступна, установите флажок Enable IO 

Module. 

10. Выберите NI 573x CLIP в списке Name раздела Component Level IP. 

11. В категории Clock Selections оставьте Clk40 сконфигурированным как 

Top-Level Clock. Это необходимо для правильной компиляции FPGA VI. 

12. Щелкните по кнопке ОК. 

Примечание Конфигурирование этого тактового сигнала необходимо для правильной 

работы CLIP. Обратитесь к разделам NI 5731/5732/5733/5734 CLIP справки NI FlexRIO 

Help для получения дополнительной информации о конфигурировании тактовых 

сигналов. 

13. В окне Project Explorer щелкните правой кнопкой мыши по целевому 

устройству FPGA и выберите New»VI. Откроется пустой VI. 

14. Выберите в меню Window»Show Block Diagram для открытия блок-

диаграммы VI. 
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15. В окне Project Explorer разверните дерево IO Module (NI 573x: NI 573x). 

16. Перетащите AI 0 на блок-диаграмму. 

17. Добавьте структуру Timed Loop вокруг узла. 

18. Подключите индикатор к выходному терминалу узла IO Module\ 

AI 0 Data N. 

19. Подключите FPGA Clock Constant ко входу узла Timed Loop. Задайте эту 

константу равной IO Module Clock 0. 

Ваша блок-диаграмма должна быть аналогична показанной на рисунке 6. 

 

Рисунок 6. Блок-диаграмма 5731/5732/5733/5734SampleAcq (FPGA).vi  

Совет Щелкните по кнопке Clean Up Diagram на панели инструментов для более 

четкой организации блок-диаграммы. 

20. Сохраните VI как 573xSampleAcq (FPGA).vi. 

21. Щелкните по кнопке Run. LabVIEW создаст компоновку требований по 

умолчанию и начнет компилировать VI. Откроется окно Generating 

Intermediate Files, в котором отображается процесс генерации кода. Затем 

откроется окно Compilation Status, где отображается процесс компиляции. 

Компиляция занимает несколько минут. 

22. Щелкните по кнопке Close в окне Compilation Status. 

23. Сохраните и закройте VI. 

24. Сохраните проект. 

Создание хост-VI 

1. В окне Project Explorer щелкните правой кнопкой мыши по My Computer 

и выберите New»VI. Откроется пустой VI. 

2. Выберите в меню Window»Show Block Diagram для открытия блок-

диаграммы VI. 

3. Поместите на блок-диаграмму функцию Open FPGA VI Reference из 

палитры FPGA Interface. 

4. Щелкните правой кнопкой мыши по функции Open FPGA VI Reference и 

выберите Configure Open FPGA VI Reference. 

5. В диалоговом окне Configure Open FPGA VI Reference выберите VI в 

разделе Open. 
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6. В диалоговом окне Select VI выберите 573xSampleAcq (FPGA).vi в разделе 

вашего устройства и щелкните по кнопке OK. 

7. Щелкните по кнопке OK в диалоговом окне Configure Open FPGA VI 

Reference. Имя целевого устройства появится под функцией Open FPGA VI 

Reference на блок-диаграмме. 

8. Добавьте на блок-диаграмму цикл While. Разместите его справа от функции 

Open FPGA VI Reference. 

9. Щелкните правой кнопкой мыши по терминалу условия в цикле While и 

выберите Create Control для создания кнопки STOP на лицевой панели VI. 

10. Добавьте функцию Read/Write Control из палитры FPGA Interface в цикл 

While. 

11. Подключите выходной терминал FPGA VI Reference Out функции Open 

FPGA VI Reference к входному терминалу FPGA VI Reference In функции 

Read/Write Control. 

12. Подключите выходной терминал error out функции Open FPGA VI 

Reference к входному терминалу error in функции Read/Write Control. 

13. Сконфигурируйте функцию Read/Write Control, щелкнув по терминалу 

Unselected и выбрав IO Module/AI 0 Data N. 

14. Подключите индикатор к выходному терминалу узла IO Module\AI 0  

Data N. 

15. Добавьте функцию Close FPGA VI Reference из палитры FPGA Interface 

справа от цикла While. 

16. Подключите терминал FPGA VI Reference Out функции Read/Write 

Control function к терминалу FPGA VI Reference In функции Close FPGA 

VI Reference. 

17. Подключите терминал error out функции Read/Write Control к терминалу 

error in функции Close FPGA VI Reference. 

Ваша блок-диаграмма должна быть аналогична показанной на рисунке 7. 

 

Рисунок 7. Блок-диаграмма 573xSampleAcq(Host).vi  

 

18. Сохраните VI как 573xSampleAcq(Host).vi. 
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Запуск хост-VI 

1. Подключите один конец кабеля BNC к разъему AI0 на лицевой панели NI 

5731/5732/5733/5734, а второй конец - к вашему тестируемому устройству. 

2. Откройте лицевую панель 573xSampleAcq(Host).vi. 

3. Щелкните по кнопке Run, чтобы запустить VI. 

4. VI собирает данные с тестируемого устройства в AI 0 Data N. 

5. Щелкните по кнопке Stop на лицевой панели и закройте VI. 

Примечание (только для NI 5731) Электростатические разряды могут повлиять на 

тактовый сигнал NI 5731, что может привести к ошибке -50400 при выполнении 

передачи данных по каналу DMA или к иным ошибкам в характеристиках тактового 

сигнала и выхода по тайм-ауту при сборе данных в NI 5731. Чтобы гарантировать, что 

NI 5731 выполнит самовосстановление после этой ошибки, хост и FPGA VI должны 

быть способны зафиксировать ошибки выхода по тайм-ауту и реинициализировать 

FPGA. Приведенные ниже два шага описывают, как реинициализировать NI 5731: 

1. Для получения дополнительной информации посетите Базу Знаний на 

странице ni.com/kb, введите информационный код 3BPD5HRY и 

выберите статью Ignoring a Particular Error in an Error Cluster in LabVIEW. 

2. Для реинилиализации FPGA обратитесь к разделу Reset (Invoke Method) 

справки NI FPGA Module Help, доступной в LabVIEW и на странице 

ni.com/manuals. 

Технические характеристики 

В этом разделе приводятся технические характеристики адаптера модуля NI FlexRIO 

(NI 5731/5732/5733/5734). Используйте эти характеристики вместе с приведенными в 

документе NI FlexRIO FPGA Module Installation Guide and Specifications. Для получения 

дополнительной информации о безопасности и электромагнитной совместимости 

обратитесь к документу Read Me First: Safety and Electromagnetic Compatibility, 

доступному с вашим оборудованием или на странице ni.com/manuals. 

Примечание Все характеристики являются типовыми, если не указано иное. На всех 

графиках отображаются характеристики типичного модуля. 

Типовые значения относятся к полезной характеристике продукта, на которую не 

распространяется гарантия. Типовые значения покрывают ожидаемое значение 

характеристики элементов в диапазоне температур 23 ±5 °C с доверительной 

вероятностью 85%, основанной на измерениях, проведенных в процессе разработки 

или изготовления. 

Примечание Технические характеристики адаптеров модулей NI 5731/5732/5733/5734 

были получены только при максимальной частоте дискретизации. 
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Аналоговый ввод (AI 0, AI 1, AI 2 и AI 3) 

Общие характеристики 

Количество каналов два (четыре для NI 5734) 

Тип разъема BNC 

Тип входа С одновременной выборкой, несимметричный 

Входной сопротивление 50  на разъеме 

Связь с источником сигнала 

(выбирается программно) 

По постоянному  или переменному току 

Коэффициент усиления (выбирается 

программно) 

0 дБ, 6 дБ, 12 дБ 

Маршруты сигнала (выбираются 

программно) 

Обход фильтра, эллиптический фильтр 7-го 

порядка, фильтр Бесселя 7-го порядка 

Разрешение оцифрованных данных (16-разрядов, выравнивание слева, без знака, двоичные 

данные) 

NI 5731 12 бит 

NI 5732 14 бит 

NI 5733/5734 16 бит 

Тип АЦП 
1
  

NI 5731 AD9231BCPZ-40 

NI 5732 AD9258BCPZ-80 

NI 5733/5734 AD9268BCPZ-125 

Абсолютное максимальное напряжение ±10В постоянного тока, 10 Впик переменного 

тока 

Отключение связи по постоянному току 

при перегрузке 

±2 В постоянного тока (превышение этого 

значения приводит к переключению в режим 

переменного тока) 

 

Типовые характеристики 

Смещение АЦП по постоянному току  

NI 5731 ±5,2 мВ 

NI 5732 ±6,6 мВ 

NI 5733/5734 ±7,1 мВ 

Выходной сигнал общего вида для 

постоянного тока  
±0,8 mV (50  terminated) 

 

 
 

                                                 
1
 Для получения дополнительной информации об АЦП в вашем устройстве, используйте приведенный шифр изделия 

для поиска соответствующего документа Analog Devices на сайте www.analog.com. 

http://www.analog.com/
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Максимальный входной сигнал 

Таблица 5. Максимальный входной сигнал 
 

Устройство Коэффициент = 0 дБ 
Коэффициент = 6 дБ 

(ПД при 0 дБ делится на 2) 

Коэффициент = 12 дБ 

(ПД при 0 дБ делится на 4) 

NI 5731 2,070 Впик 1,035 Впик 0,5175 Впик 

NI 5732 2,055 Впик 1,028 Впик 0,5138 Впик 

NI 5733/5734 2,085 Впик 1,043 Впик 0,5212 Впик 
 

ПД – полный диапазон  

Отклонение коэффициента усиления по постоянному току, 

Таблица 6. Погрешность коэффициента усиления по постоянному току (полный диапазон) 
 

Устройство Коэффициент = 0 дБ Коэффициент = 6 дБ Коэффициент = 12 дБ 

NI 5731 ±0,9% ±1,2% ±1,7% 

NI 5732 ±0,5% ±0,8% ±1,4% 

NI 5733/5734 ±0,6% ±0,8% ±1,5% 
 

Шумы 

Таблица 7. Средняя плотность шума 
 

Устройство Коэффициент 

усиления (дБ) 

Полный 

диапазон 

(Впик) 

Средняя плотность шума 

(нВ/√Гц) (дБм/Гц) (дБПД/Гц) 

NI 5731 0 2,070 61,5 –131,2 –141,2 

6 1,035 33,0 –136,6 –140,6 

12 0,5175 18,6 –141,6 –139,6 

NI 5732 0 2,055 33,4 –136,5 –148,4 

6 1,0275 18,3 –141,7 –147,6 

12 0,51375 10,7 –146,4 –146,3 

NI 5733/5734 0 2,085 26,9 –138,4 –148,4 

6 1,0425 14,8 –143,6 –147,6 

12 0,52125 8,6 –148,3 –146,3 

Полоса пропускания 

Нижняя частота среза для связи по 

переменному току (–3 дБ) 

20 кГц 

Нижняя частота среза для связи по 

постоянному току (–3 дБ) 

0 Гц 

Таблица 8. Полоса пропускания до верхней частоты среза (–3 dB) 
 

Устройство Без фильтра Эллиптический фильтр Фильтр Бесселя 

NI 5731 120 МГц 15,8 МГц 8,1 МГц 

NI 5732 110 МГц 29,6 МГц 16,1 МГц 

NI 5733/5734 117 МГц 37,1 МГц 24,1 МГц 
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Неравномерность групповой задержки 

 

Таблица 9. Максимальная частота до 2 нс 
 

Устройство Эллиптический фильтр Фильтр Бесселя 

NI 5731 9 МГц 18 МГц 

NI 5732 20 МГц 37 МГц 

NI 5733/5734 30 МГц 53 МГц 

Отношение сигнал-шум1
 

Таблица 10. Отношение сигнал-шум (SNR
1
) 

 

Устройство Вход Коэффициент =  

0 дБ 

Коэффициент =  

6 дБ 

Коэффициент =  

12 дБ 

NI 5731 4,9 МГц 67,2 дБ 66,6 дБ 65,6 дБ 

NI 5732 9,7 МГц 69,5 дБ 68,7 дБ 67,4 дБ 

NI 5733/5734 9,7 МГц 69,6 дБ 68,8 дБ 67,5 дБ 

Суммарный коэффициент гармонических искажений1
 

Таблица 11. Суммарный коэффициент нелинейных искажений (THD
1) 

 

Устройство Вход Коэффициент =  

0 дБ 

Коэффициент =  

6 дБ 

Коэффициент =  

12 дБ 

NI 5731 4,6 МГц –87,1 дБн –87,1 дБн –84,1 дБн 

NI 5732 9,7 МГц –83,9 дБн –87,7 дБн –89,5 дБн 

NI 5733/5734 9,7 МГц –80,5 дБн –85,0 дБн –86,0 дБн 

 

Гинамический диапазон без паразитных составляющих1
 

Таблица 12. Динамический диапазон без паразитных составляющих (SFDR
2
) 

 

Устройство Вход Коэффициент =  

0 дБ 

Коэффициент =  

6 дБ 

Коэффициент =  

12 дБ 

NI 5731 4,9 МГц –87 dBc –87 dBc –90 dBc 

NI 5732 9,7 МГц –85 dBc –89 dBc –91 dBc 

NI 5733/5734 9,7 МГц –83 dBc –86 dBc –87 dBc 

Перекрестные помехи между каналами аналогового ввода 

Примечание Приведенные ниже таблицы были получены при измерении с 

коэффициентом 0 дБ для сигнала уровнем –1 дБ от полной шкалы частотой 10 МГц на 

канале источника, в то время как другие каналы согласованы на 50 Ом. При измерении 

перекрестных помех с коэффициентами 6 дБ и 12 дБ, перекрестные помехи на 6 дБ и 12 

дБ хуже, соответственно. 

 

                                                 
1
 Измерено при –1 дБ от полной шкалы. 

2
 Измерено при –1 дБ от полной шкалы. 
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Таблица 13. NI 5731/5732/5733/5734: Перекрестные помехи канала AI 
 

Номер канала-

источника (0..3) 

Канал-приемник (согласован 50 Ом) 

Маршрут в соседнем канале (N-1) Маршрут в соседнем канале (N+1) 

Без  

фильтра 

Эллиптический Бесселя Без  

фильтра 

Эллиптический Бесселя 

Без фильтра -102 дБ -97 дБ -100 дБ -98 дБ -89 дБ -81 дБ 

Эллиптический 

фильтр 

-102 дБ -77 дБ -81 дБ -104 дБ -79 дБ -77 дБ 

Фильтр Бесселя -87 дБ -73 дБ -77 дБ -103 дБ -83 дБ -80 дБ 
 

Примечание Только для устройств NI 5731/5732 - перекрестные помехи на 4 дБ 

хуже, чем приведено в таблице 13, если оба канала сконфигурированы на 

использование фильтров.  

 

Таблица 14. Только для NI 5734: Перекрестные наводки канала AI 
 

Номер канала- 

источника (0..3) 

Канал-приемник (согласован 50 Ом) 

Маршрут канала (N ± 2) Маршрут канала (N ± 3) 

Без фильтра Эллиптический 

фильтр или 

фильтр Бесселя 

Без фильтра Эллиптический 

фильтр или 

фильтр Бесселя 

без фильтра -112 дБ -102 дБ -112 дБ -107 дБ 

Эллиптический фильтр -112 дБ -85 дБ -112 дБ -90 дБ 

Фильтр Бесселя -112 дБ -86 дБ -112 дБ -90 дБ 

 

Диапазон подстройки фазы DAC   

NI 5731 406 ± 13 градусов 

NI 5732 427 ± 13 градусов 

NI 5733/5734 429 ± 9 градусов 

Диапазон подстройки частоты DAC ± 160 ppm 

Частота сбора данных 

(IOModuleClock0) 

Частота дискретизации 
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Измерения 

Частотная характеристика 

 
Рисунок 8. Частотная характеристика для низких частот при связи по переменному току 

(наложены несколько каналов) 

 

Рисунок 9. Частотная характеристика без фильтра (наложены несколько каналов) 
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Рисунок 10. Частотная характеристика эллиптического фильтра  

(наложены несколько каналов) 

 

Рисунок 11. Частотная характеристика эллиптического фильтра: от 0 до -6дБ  

(наложены несколько каналов) 
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Рисунок 12. Частотная характеристика фильтра Бесселя (наложены несколько каналов) 

 

 

Рисунок 13. Частотная характеристика фильтра Бесселя: от 0 до -6дБ  

(наложены несколько каналов) 
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Групповая задержка NI 5731 

 

Рисунок 14. Групповая задержка эллиптического фильтра NI 5731 (наложены 12 каналов) 

 

 

Рисунок 15. Групповая задержка фильтра Бесселя NI 5731 (наложены 12 каналов) 
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Групповая задержка NI 5732 

 
Рисунок 16. Групповая задержка эллиптического фильтра NI 5732 (наложены 12 каналов) 

 

 
Рисунок 17. Групповая задержка фильтра Бесселя NI 5732 (наложены 12 каналов) 
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Групповая задержка NI 5733/5734  

 
Рисунок 18. Групповая задержка эллиптического фильтра NI 5733/5734 (наложены 44 канала) 

 

 
Рисунок 19. Групповая задержка фильтра Бесселя NI 5733/5734 (наложены 44 канала) 
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Полный фазовый шум аналогового ввода 

NI 5731 

 

Рисунок 20. Фазовый шум аналогового ввода NI 5731  

(вход 10 МГц, без ФАПЧ, встроенный осциллятор, 618 ПД джиттера СКЗ) 

NI 5732 

 

Рисунок 21. Фазовый шум аналогового ввода NI 5732  

(вход 23,17 МГц, без ФАПЧ, встроенный осциллятор, 466 ПД джиттер СКЗ) 
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NI 5733/5734 

 

Рисунок 22. Фазовый шум аналогового ввода NI 5733/5734  

(вход 40 МГц, без ФАПЧ, встроенный осциллятор, 453 ПД джиттер СКЗ) 

 

Рисунок 23. Фазовый шум аналогового ввода NI 5733/5734  

(вход 40 МГц, ФАПЧ замкнута на опорный сигнал PXI 10 МГц,  
встроенный осциллятор, 448 ПД джиттер СКЗ) 
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Измерение спектра при согласованном входе  

(16 382 точек БПУ, усреднение по 30, СКЗ) 

NI 5731 

 

Рисунок 24. Коэффициент усиления NI 5731 - 0 дБ; эллиптический фильтр, фильтр Бесселя или 

без фильтра; связь по переменному или постоянному току 

 

Рисунок 25. Коэффициент усиления NI 5731 - 12 дБ; эллиптический фильтр, фильтр Бесселя или 

без фильтра; связь по переменному или постоянному току 
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NI 5732 

 
Рисунок 26. Коэффициент усиления NI 5732 - 0 дБ; эллиптический фильтр, фильтр Бесселя или 

без фильтра; связь по переменному или постоянному току 

 

 
Рисунок 27. Коэффициент усиления NI 5732 - 12 дБ; эллиптический фильтр, фильтр Бесселя или 

без фильтра; связь по переменному или постоянному току 
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NI 5733/5734 

 
 

Рисунок 28. Коэффициент усиления NI 5733/5734 - 0 дБ; эллиптический фильтр, фильтр Бесселя 

или без фильтра; связь по переменному или постоянному току 

 
Рисунок 29. Коэффициент усиления NI 5733/5734 - 12 дБ; эллиптический фильтр, фильтр 

Бесселя или без фильтра; связь по переменному или постоянному току 
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Измерения спектра (16382 точек БПУ) 

NI 5731 

 

Рисунок 30. Коэффициент усиления NI 5731 0 дБ: –1 дБПД при 4,9 МГц, –95 дБн SFDR,  

без фильтра, СКЗ по 100 усреднениям 

 
Рисунок 31. Коэффициент усиления NI 5731 12 дБ: –1 дБПД при 4,9 МГц, -93 дБн SFDR,  

без фильтра, усреднение по 100 СКЗ 
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Рисунок 32. Коэффициент усиления NI 5731 12 дБ: –1 дБПД при 4,9 МГц, -93 дБн SFDR,  

без фильтра, усреднение по 100 СКЗ 

NI 5732 

 
Рисунок 33. Коэффициент усиления NI 5732 0 дБ: –1 дБПД при 9,7 МГц, -91 дБн SFDR,  

без фильтра, усреднение по 100 СКЗ 
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Рисунок 34. Коэффициент усиления NI 5732 12 дБ: –1 дБПД при 9,7 МГц, -94 дБн SFDR,  

без фильтра, усреднение по 100 СКЗ 

 
Рисунок 35. Коэффициент усиления NI 5732 12 дБ: –1 дБПД при 9,7 МГц, -94 дБн SFDR, без 

фильтра, усреднение по 100 СКЗ 
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NI 5733/5734 

 
Рисунок 36. Коэффициент усиления NI 5733/5734 при 0 дБ: –1 дБПД при 20,1 МГц, -85 дБн SFDR, 

без фильтра, усреднение по 100 СКЗ 

 

Рисунок 37. Коэффициент усиления NI 5733/5734 при 12 дБ: –1 дБПД при 20,1 МГц, -87 дБн 

SFDR, без фильтра, усреднение по 100 СКЗ 
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Рисунок 38. Коэффициент усиления NI 5733/5734 при 12 дБ: –1 дБПД при 20,1 МГц, -87 дБн 

SFDR, без фильтра, усреднение по 100 СКЗ 

Гвухтональное БПУ 

 

Рисунок 39. NI 5732 с коэффициентом усиления 12 дБ, без фильтра: –83 дБн,  

fin = 19,6 МГц (–7 дБПД), 20,8 МГц (–7 дБПД), усреднение по 100 СКЗ 
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Рисунок 40. NI 5733/5734 с коэффициентом усиления 12 дБ, без фильтра: -81 дБн, 

 fin = 19,6 МГц (–7 дБПД), 20,8 МГц  

Внутренний генератор импульсов отсчетов 

Общие характеристики 

Распределитель тактовых импульсов, 

шифр изделия 

AD9511
1
 распределитель импульсов 

Тип осциллятора VCXO 

Модель осциллятора Epson Toyocom TCO–2121U2 

Частота  

NI 5731 40 МГц ± 50 ppm 

NI 5732 80 МГц ± 100 ppm 

NI 5733/5734 120 МГц ± 100 ppm 

Фазовый шум Обратитесь к разделу Полный фазовый шум 

аналогового ввода 

Типовые характеристики 

Нестабильность частоты  

Температурная 30 ppm в рабочем диапазоне температур 

Временная ±5 ppm в год 

                                                 
1
 Для получения дополнительной информации об AD9511 обратитесь к документу Analog Devices на сайте 

www.analog.com. 

http://www.analog.com/
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CLK IN 

Общие характеристики 

Количество каналов 1, несимметричный 

Тип разъема SMB 

Входной импеданс 50   

Связь с источником сигнала по переменному току (AC) 

Диапазон входного напряжения 0,40 Впик до 5,2 Впик 

Абсолютное максимальное напряжение 8,0 В постоянного тока, 8,0 Впик 

Коэффициент заполнения от 40% до 60% 
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Таблица 15. Источники тактового сигнала NI 5731/5732/5733/5734 

Конфигурация 

тактового 

сигнала 

Поддерживаемые 

частоты, 

МОтсчетов/с 

Тип 

внешнего 

тактового 

сигнала 

Частота внешнего 

тактового сигнала, 

МГц 
Описание 

Встроенный 

тактовый 

генератор 

без ФАПЧ 

NI 5731 = 40 

NI 5732 = 80 

NI 5733 = 120 

NI 5734 = 120 

— — Внутренний кварцевый 

генератор, работающий 

как независимый 

генератор тактовых 

импульсов. 

Встроенный 

тактовый 

генератор 

с ФАПЧ 

(IoModSynClk) 

NI 5731 = 40 

NI 5732 = 80 

NI 5733 = 120 

NI 5734 = 120 

— 10  Внутренний кварцевый 

генератор синхронизи-

руется IoModSyncClk 

(Sync Clock), который 

поступает только через 

объединительную 

панель поддержива-

емых устройств. 

Встроенный 

тактовый 

генератор 

с ФАПЧ 

CLK IN 

NI 5731 = 40 

NI 5732 = 80 

NI 5733 = 120 

NI 5734 = 120 

Reference 

clock 

10  Внутренний кварцевый 

генератор синхронизи-

руется внешним 

сигналом Reference 

clock, который 

поступает через разъем 

лицевой панели CLK 

IN. 

Внешний 

генератор 

(CLK IN) 

Поддерживаемая 

тактовая частота 

равна частоте 

внешнего тактового 

сигнала 

 

Sample 

clock 

NI 5731 мин, = 3  Внешний тактовый 

сигнал можно 

подключать через 

разъем лицевой панели  

CLK IN. 

NI 5731 макс, = 40  

NI 5732 мин = 20 * 

NI 5732 мин = 10 † 

NI 5732 макс, = 80  

NI 5733 мин = 50  

NI 5733 макс, = 120 

NI 5734 мин = 50  

* со включенным стабилизатором скважности (DCS). По умолчанию стабилизатор скважности 

включен во всех элементах CLIP NI 5731/5732/5733/5734. Вы можете выключить DCS с 

помощью регистра 9 АЦП. 

† DCS отключен. 
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AUX I/O (Порт 0 DIO <0..3>, порт 1 DIO <0..3> и PFI <0..3>) 

Общие характеристики 

Количество каналов 12 двунаправленных (8 DIO и 4 PFI) 

Тип разъема HDMI 

Стандарт интерфейса 3,3 В LVCMOS 

Логика интерфейса  

VIL макс. 0,8 В 

VIH мин. 2,0 В 

VOL макс. 0,4 В 

VОH мин. 2,7 В 

VОH макс. 3,6 В 

Zout 50 Ом ± 20% 

Iout (DC) ±2 мА 

Подтягивающий резистор 150 кОм 

Рекомендуемое рабочее напряжение от -0,3 В до 3,6 В 

Защита от перегрузки по напряжению ±10 В 

Максимальная частота переключений 6,6 МГц 

Максимальная мощность при +5 В 10 мА 

Допустимое отклонение напряжения  

+5 В 
от 4,2В до 5 В 

Питание 

Полная мощность в номинальном режиме 

NI 5731 1,7 Вт 

NI 5732 2,1 Вт 

NI 5733 2,6 Вт 

NI 5734 4,5 Вт 

Уизические характеристики 

Размеры 12,9  2,0  12,1 см 

Вес  

NI 5731/5732/5733 313 г 

NI 5734 332 г 

Разъемы лицевой панели BNC, SMB и HDMI 
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Условия эксплуатации 

Диапазон рабочих температур
1
 от 0 C до 55 C, Протестировано в 

соответствии со стандартами IEC-60068-2-1 и 

IEC-60068-2-2 

Относительная влажность от 10% до 90%, без конденсата, протестировано 

в соответствии со стандартом IEC-60068-2-56 

Степень загрязнения 2 

Высота над уровнем моря 2000 м 

Для эксплуатации только в помещении, 

Условия хранения  

Диапазон температур при 

хранении 
от -20 C до 70 C, Протестировано в 

соответствии со стандартами  

IEC-60068-2-1 и IEC-60068-2-2 

Относительная влажность от 5% до 95%, без конденсата, протестировано в 

соответствии со стандартом IEC-60068-2-56 

 

Примечание Очищайте устройство мягкой, неметаллической кисточкой. Убедитесь, 

что устройство полностью сухо и свободно от загрязнений перед его повторным 

включением. 

Удары и вибрации 

Удары в условиях эксплуатации Пиковая величина 30 g, полупериод синуса, 

импульс 11 мс (Протестировано в соответствии 

со стандартом IEC-60068-2-27. Режим 

испытаний разработан в соответствии  

с MIL-PRF-28800F) 

Случайные вибрации  

В процессе эксплуатации От 5 Гц до 500 Гц, 0,3 g СКЗ 

Не в процессе эксплуатации От 5 до 500 Гц, 2,4 g СКЗ. Протестировано в 

соответствии со стандартом IEC-60068-2-64, 

Тестовый профиль не в процессе эксплуатации 

превышает требования MIL- PRF-28800F,  

класс 3). 

Безопасность 

Изделие соответствует требованиям следующих стандартов по безопасности 

электрооборудования для измерений, управления и лабораторного применения: 

 

                                                 
1
 Для конфигураций шасси PXI/PXI Express с адаптерами модулей NI FlexRIO в трех или более соседних слотах National 

Instruments рекомендует при эксплуатации ограничивать температуру окружающей среды ниже 50 C 
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 IEC 61010-1, EN 61010-1 

 UL 61010-1, CSA 61010-1 

Примечание: Информацию о сертификатах UL и других сертификатах безопасности 

можно найти на товарной этикетке, или в разделе Онлайн- сертификация. 

Электромагнитная совместимость 

Изделие удовлетворяет требованиям следующих стандартов по электромагнитной 

совместимости (ЭМС) электрооборудования для измерений, управления и лабораторного 

применения: 

• EN 61326-1 (IEC 61326-1): Требования к ЭМС; Класс А; Минимальные требования 

к помехозащищенности 

• EN 55011 (CISPR 11): Группа 1; Класс А излучений 

• AS/NZS CISPR 11: Группа 1; Класс А излучений 

• FCC 47 CFR Часть 15B: Класс А излучений 

• ICES-001): Класс А излучений 

Примечание В Соединенных Штатах (согласно федеральному закону FCC 47 CFR), 

оборудование класса А предназначено для использования в коммерческих зданиях, 

зданиях легкой и тяжелой промышленности. В Европе, Канаде, Австралии и Новой 

Зеландии (согласно CISPR 11) оборудование класса А предназначено для 

использования только в зданиях тяжелой промышленности. 

Примечание К оборудованию группы 1 (по CISPR 11) относится любое 

промышленное, научное или медицинское оборудование, которое не генерирует 

намеренно радиочастотную энергию для обработки материалов, дефектоскопии или 

анализа. 

Примечание За получением деклараций и сертификатов о соответствии требованиям 

стандартов по электромагнитной совместимости, а также дополнительной информации, 

обратитесь к разделу Онлайн-сертификация. 

Соответствие требованиям Совета Европы   

Изделие соответствует основным требованиям следующих директив СЕ: 

 2006/95/EC; Директива по безопасности низковольтного оборудования 

 2004/108/EС; Директива по ЭМС 

Oнлайн-сертификация 

Для получения сертификатов и Декларации о соответствии (DoC) этого изделия посетите 

страницу ni.com/certification, выполните поиск по серии и номеру модели, и 

щелкните по соответствующей ссылке в столбце Certification. 
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Охрана окружающей среды 

NI разрабатывает и производит продукцию с учетом требований по защите окружающей 

среды и принимает во внимание, что отказ от использования некоторых опасных веществ 

при изготовлении изделий полезен как для среды обитания, так и для потребителей. 

Дополнительная информация по защите окружающей среды находится на странице NI and 

the Environment по адресу ni.com/environment. Эта страница содержит положения и 

директивы по охране окружающей среды, которые соблюдает компания NI, а также другая 

информация о защите окружающей среды, не включенная в настоящий документ. 

Утилизация электрического и электронного оборудования 

(WEEE) 

Пользователям из стран ЕС: По истечении срока службы любая продукция должна 

быть отправлена в центр по переработке электрического и электротехнического 

оборудования (WEEE). Для получения информации о WEEE центрах по переработке, 

инициативах National Instruments по WEEE, а также о соответствии с WEEE Директивой 

2002/96/ЕС обратитесь на сайт ni.com/environment/weee. 

电子信息产品污染控制管理办法（中国 RoHS） 

 中国客户 National Instruments 符合中国电子信息产品中限制使用某些有害物 

质指令(RoHS). 关于 National Instruments 中国 RoHS 合规性信息，请登录 

ni.com/environment/rohs_china. (Для получения информации о директиве по 

ограничению вредных веществ в Китае, обратитесь на страницу 

ni.com/environment/rohs_china.) 

Куда обратиться за поддержкой 

Веб-сайт National Instruments является полноценным ресурсом вашей технической 

поддержки. На ni.com/support вы можете получить любую информацию, начиная с 

выявления неисправностей и ресурсов для самостоятельного поиска ответов по 

разработке приложений и заканчивая возможностью поддержки по электронной почте 

либо по телефону специалистами NI. 

Штаб-квартира корпорации National Instruments располагается по адресу 11500 North 

Mopac Expressway, Austin, Texas, 78759-3504. Также National Instruments имеет офисы 

по всему миру для обеспечения технической поддержки Для получения поддержки по 

телефону в США создайте запрос на странице ni.com/support и следуйте 

инструкциям, или позвоните по номеру 512 795 8248. Для получения поддержки по 

телефону вне Соединенных Штатов вы можете также посетить раздел Worldwide Offices 

на сайте ni.com/niglobal для доступа к веб-сайтам филиалов, где имеется 

обновляемая контактная информация, телефоны службы поддержки, адреса 

электронной почты и информация о текущих событиях.



Приложение: Установка элементов для уменьшения 

уровня электромагнитных помех 

Для обеспечения указанных характеристик электромагнитной совместимости в 

вашей системе NI FlexRIO должны быть установлены панели-заглушки PXI 

EMC и ферритовое кольцо на кабель HDMI. В ваш комплект поставки 

включено ферритовое кольцо на кабель HDMI, но панели-заглушки PXI EMC 

(шифр изделия National Instruments 778700-01) необходимо приобретать 

отдельно.  

Дополнительная информация по установке приведено в документе FlexRIO 

FPGA Module Installation Guide and Specifications. 

Установка панелей-заглушек PXI EMC 

Выполните следующие инструкции, чтобы установить панели-заглушки PXI 

EMC для уменьшения электромагнитного излучения (шифр изделия National 

Instruments 778700-01) в ваше шасси PXI: 

1. Снимите крышки невыпадающих винтов. 

2. Установите панели-заглушки PXI EMC, прикрепив невыпадающие болты к 

шасси, как показано на рисунке 41. Убедитесь, что уплотнитель для защиты 

от EMC находится с правой стороны панели-заглушки PXI. 

 
1 Крышки невыпадающих винтов 2 Невыпадающие винты 3 Уплотнитель для EMC 

 

Рисунок 41. Шасси и панели-заглушки PXI EMC 



 

 

Примечание Вы должны заполнить все слоты модулями или панелями-заглушками 

PXI EMC, чтобы обеспечить правильное охлаждение модуля. Не затягивайте винты 

слишком сильно (максимум 2,5 фунта·дюйм). Для получения дополнительной 

информации об использовании панелей-заглушек PXI EMC в вашей системе PXI 

откройте страницу ni.com/info и введите информационный код emcpanels. 

Установка феррита на кабель HDMI 

Выполните следующие инструкции для установки ферритового кольца, 

входящего в комплект поставки, на ваш кабель HDMI. Установите ферритовое 

кольцо на конец кабеля HDMI, который ближе к разъему AUX I/O. 

1. Откройте кольцо, разомкнув зажим. 

2. Вставьте кабель HDMI в феррит. 

3. Закройте феррит вокруг кабеля, пока кольцо не защелкнется. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
LabVIEW, National Instruments, NI, ni.com, логотип корпорации National 
Instruments и логотип с орлом являются торговыми марками корпорации National 
Instruments. За информацией о других торговых марках корпорации National 
Instruments обратитесь к разделу Trademark Information на сайте 

ni.com/trademarks. Названия других упомянутых в данном руководстве 
изделий и производителей также являются торговыми марками или торговыми 
именами соответствующих компаний. Для получения информации о патентах, 
которыми защищены продукция или технологии National Instruments, выполните 
команду Help»Patents из главного меню вашего программного обеспечения, 
откройте файл patents.txt на имеющемся у вас компакт-диске или зайдите 

на сайт ni.com/patents. Обратитесь к документу Export Compliance 

Information на сайте ni.com/legal/export-compliance за глобальными 
принципами торговой политики National Instruments. 
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